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Introduction

The Affymetrix® miRNA QCTool enables a variety of analysis methods tailored to miRNA studies and
features extensive quality control tools. Several methods of probe signal background subtraction, array
normalization (including the use of internal normalization controls), and probe set summarization are
allowed, in various combinations. If you are using internal normalization controls, you can apply the
default probe sets (human 5.8S rRNA) or choose from any set of the probe sets on the array, including
snoRNAs, miRNAs (any species), or spike-in controls. The miRNA QCTool is thus applicable to a wide
variety of experimental designs.

There are 2 versions of the tools that are available on the Affymetrix website. Please choose the correct
version depending on array type (see Table 1.1).

Table 1.1 miRNA QCTool version for Array Types

Affymetrix® Array Type Tool to Use
miRNA v1.0 Array miRNA QCTool, version 1.0.33.0
miRNA v2.0 Array miRNA QCTool, version 1.1.1.0 or greater

n IMPORTANT: Data from the GeneChip® miRNA 2.0 Arrays use will need to install miRNA
QCTool version 1.1.1.0. If the previous version of the miRNA QCTool (version 1.0.33.0) has
been installed on your computer, please un-install version 1.0.33.0 and reboot the computer
before installing version 1.1.1.0. This is required because GeneChip miRNA 2.0 Arrays are not
compatible with miRNA QCTool version 1.0.33.0 and GeneChip® miRNA Arrays are not
compatible with QCTool version 1.1.1.0.

If you are processing both GeneChip miRNA Arrays and GeneChip miRNA 2.0 Arrays you will be
required to use a second computer because both versions of the miRNA QCTool cannot be installed on
the same computer.

Conventions Used in This Guide

This guide provides a detailed outline for all tasks associated with Affymetrix® GeneChip Command
Console. Various conventions are used throughout the guide to help illustrate the procedures described.
Explanations of these conventions are provided below.

Steps

Instructions for procedures are written in a step format. Immediately following the step number is the
action to be performed. Following the response additional information pertaining to the step may be
found and is presented in paragraph format. For example:

1. Click Yes to continue.

The Delete task proceeds.
In the lower right pane the status is displayed.

To view more information pertaining to the delete task, right-click Delete and select View Task Log
from the shortcut menu that appears.
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Font Styles

Bold fonts indicate names of commands, buttons, options or titles within a dialog box. When asked to
enter specific information, such input appears in italics within the procedure being outlined.
For example:

1. Click the Find button or select Edit — Find from the menu bar.
The Find dialog box appears.
2. Enter AFFX-BioB-5_at in the Find what box, then click Find Next to view the first search result.

3. Continue to click Find Next to view each successive search result.

Screen Captures

The steps outlining procedures are frequently supplemented with screen captures to further illustrate the
instructions given. The screen captures depicted in this guide may not exactly match the windows
displayed on your screen.

Additional Comments

E TIP: Information presented in Tips provide helpful advice or shortcuts for completing a task.

NOTE: The Note format presents important information pertaining to the text or procedure
being outlined.

n IMPORTANT: The Important format presents important information that may affect the
accuracy of your results.

CAUTION: Caution notes advise you that the consequence(s) of an action may be irreversible
and/or result in lost data.

u WARNING: Warnings alert you to situations where physical harm to person or damage to
hardware is possible.
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Resources

Documentation

This manual is available in Adobe Acrobat format (as *.pdf files) on the CD and is readable with the
Adobe® Acrobat Reader® software, available at no charge from Adobe at http://www.adobe.com.

Technical Support

Affymetrix provides technical support to all licensed users via phone or E-mail. To contact Affymetrix®
Technical Support:

Affymetrix, Inc.
3420 Central Expressway

Santa Clara, CA 95051 USA

E-mail: support@affymetrix.com

Tel: 1-888-362-2447 (1-888-DNA-CHIP)
Fax: 1-408-731-5441

Affymetrix UK Ltd.
Voyager, Mercury Park

Wycombe Lane, Wooburn Green

High Wycombe HP10 OHH

United Kingdom

UK and Others Tel: +44 (0) 1628 552550
France Tel: 0800919505

Germany Tel: 01803001334

E-mail: supporteurope@affymetrix.com
Tel: +44 (0) 1628 552550

Fax: +44 (0) 1628 552585

Affymetrix Japan, K. K.
ORIX Hamamatsucho Bldg, 7F

1-24-8 Hamamatsucho, Minato-ku
Tokyo 105-0013 Japan

Tel: +81-3-6430-4020

Fax: +81-3-6430-4021
salesjapan@affymetrix.com

supportjapan@affymetrix.com
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miRNA QCTool Software Installation and First Steps

Installing the miRNA QCTool Software

Software Requirements

The miRNA QCTool software can be installed on the following operating systems:
= Microsoft Windows 2000 Professional with Service Pack 4.0 or higher

= Microsoft Windows XP with Service Pack 2.0 or higher

= Microsoft Windows Vista with Service Pack 1.0 or higher

= Microsoft.Net 2.0

Minimum Hardware Recommendations

The minimum hardware recommendations are:

= Memory (RAM): 1 GB (2 GB of RAM is recommended)
= Hard drive: 20 GB
= Processor: 2.0 GHz Intel Pentium or better

Software Installation

1. Install the software on a Microsoft Windows operating system by double clicking on the setup
program.

The miRNA QCTool Setup window appears (Figure 2.1).

Welcome to the miRNA QCTool Setup Wizard

The inztaller will guide you through the steps required to inzstall miBMA OCT ocl on your computer.

WARMIMG: This computer program iz protected by copyright law and internalional treaties.
Unautharized duplicaticn or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the masimum extent possible uhder the law.

Cancel 4 Back | Mext > I

Figure 2.1 Setup Window

2. Click Next.
The miRNA QCTool License Agreement appears (Figure 2.2).
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License Agreement

Please take a moment ta read the license agreement now. |F pou accept the terms below, click "l
Agree", then "Mext". Otherwize click "Cancel”.

Destination Control Statement

L

For the purposes of this Destination Control Statement (“DCS”), the use
of 'export' shall mean the transfer of Products outside of the
continental United States. End User acknowledges that the exportation
of Products is subject to compliance under the United States Export
Control Administration Act of 1979 and the Export Administration Act of
1985, as they may be amended from time to time, and the rules andLI

| Do Mot Agree & | Agres

Cancel | < Back | Mest > I

Figure 2.2 miRNA QCTool License Agreement

3. Read the License Agreement and select I Agree.
Selecting I Do Not Agree or Cancel will close the installer and miRNA QCTool will not be installed.
Click Next to continue. The Select Installation Folder appears (Figure 2.3).

Select Installation Folder

The installer will install mifkA GCT ool bo the following folder.

Ta inztall in this folder, click “Mext™. Toinstall to a different folder. enter it below or click “Browse'.

Folder:

C:Program Files\AffumetrizsmiRNa OCT aolt Browse... |
Disk Cost... |

Install miRNA QCTool for yourself, or for anyone who uses this computer:

' Everyone
£ Just me

Cancel | < Back | Mest > I

Figure 2.3 Select Installation Folder window

NOTE: The settings displayed in Figure 2.3 show just one example of a location to install the
software. You may install Affymetrix® miRNA QCTool software elsewhere, if desired.

4. In the Select Installation Folder window:
A. Click Browse to select the installation Folder.
B. Click Everyone or Just me to define who will be allowed to use the software.
C. Click Next to proceed.
The Installation Complete window appears (Figure 2.4).
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Installation Complete

mifMA QCT ool has been successfully installed.

Click "Close" t2 exit.

Fleaze uze Windows Update to check for any critical updates to the \MET Framework.

Lancel | < Back | Close I

Figure 2.4 Installation Complete window

First Steps

Starting the miRNA QCTool Software
After installation of the miRNA QCTool program, launch the software by using one of two options:

= Click the desktop icon labeled “miRNA QCTool” or
= Launch the miRNA QCTool by clicking Start — All Programs — Affymetrix — miRNA QCTool.

The first operation is the loading of the necessary CEL files by using the CEL selection window (see
Selection of Input Data: CEL Files on page 11 for details). Once this step is accomplished, the software
is able to process the raw data based on a pre-defined workflow of analysis steps. Workflow Editing on
page 23 explains how to configure, edit and save workflows.

The miRNA QCTool has been configured with the necessary information files (the default setup), so that
the GC content for each probe and the list of background probes are automatically loaded upon starting.
The section, Software Settings (below) explains how to reconfigure these settings.

Software Settings

The ability to change library file locations is available by accessing the Tools menu option and then
clicking Settings and Options... A simple settings window allows the user to update the probe array
information (see Figure 2.5), including the name and location of the CDF, annotation, and background
files. The “default” files are the ones shipped with the program. The software settings include the CDF
File, Annotation File, Background BGP File, List of Probe Files and Quality Control QCC Files.
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1§ x|
—CDF File
IC:\Documents and Settings"All Users'\Application Data" Affymetric'\miRNA QCTool\miRNA-2_0.cdf Browse | Default |

r— Annotation File
IC:‘~.D0c:1.|ment5 and Settings Al Users' Application Data"Affymetri'\miRNA QCTool'miRNA-2_0 annotations 20101222 csv Browse | Default |

r— Background BGP File

IC:\Documents and Settings Al Users'Application Data" Affymetri'miRNA QCTool'miRNA-Z_0bgp Browse | Default |
r— List of Probes File

IC:\Documents and Settings"All Users'Application Data"Affymetric'miRNA QCTool'\miRMNA-Z_0 probe _list ted Browse | Default |
r— Quality Control GCC File

IC:\Documents and Settings"All Users'\Application Data" Affymetric'miRNA QCTool'miRNA-2_0.gecc Browse | Default |

Clean Termp Fles | Cancel | ok |

Figure 2.5 Settings window for updating configuration files

Window Arrangement

Windows arrangement is available through the Window menu option. This feature allows for the
arrangement of open windows (tables and graphs), manually or automatically. Figure 2.6 and Figure 2.7
show two arrangement examples: (a) MvA and box plot graphs automatically in vertical tile mode, and
(b) an MvA graph, a box plot graph and a data table manually in cascade window style.

iRNAQCTool

File  Analysis Tables Graphs Tools WVWindow  Help

B Mter Summarization {Median Palish) - Log2 applied by process:
16
10
561
4 —_— e —=——m ==
-4 1 - 4 1 2671
=5 A
17.81
&
£ 88
5 13
X
= o
2
8
19 5 0
5
25 23
-3 4781
3
i 2671
42
| = E It = | | i -3561
= A T T T S &
B = E= = = Z = = P
20 17 13 9 % ; 1 5 9 12
Mean values
" Show Details it \

Figure 2.6 Example of multiple window arrangement: Vertical tile mode
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11 mitNAQCTool I
File  Analysis  Tables Graphs  Tools  Window  Help
=
1# Mva Plot | I
i,}{ Data Table gl 10 I’
Data after Summarization (Median Polish) - Loa2 applied by process,
ProbeSet Name | HuLung_... | p-value (... | Detectio... | HuBrain... | p-value (... | Detectio... | HuBrain... |p-value (.2
celdet-Tstar st 3537564 0.6353688 False 3.606683 0.9783676 False 3.60258627 0.9587671
cellind st 380536461 07640221 False 393884939 01489643 False 392063522 04428738
celdin-d-star st 4151954 0.4538723 False 3.21604052 0455922 False 375162362 0.7055292
celmif-1 st 404034138 0.7223458 Falss 412295055 04366831 Falss 3.971281 0.6307727
celmif-2 st 3955419 0.656993 False 362169933 09314729 False 4 06695366 0.5779365
if-34 st 3641423 0.7425691 False 355160761 0.5280683 False 37847123 0.3372566
miFi-. 4720758 0185002 False 516430426 004305352 Tre 5136764 0.02023635
iR-25 st 3815388 0.3853876 False 3.22992085 087428435 False 160762239 0.9819251
celmif-36 st 418767166 01518112 Falss 419785028 01480861 Falss 3.973745 0.3414308
cel-miR-37-star st 378736687 0.7755316 False 377236366 0.8254501 False 250533543 10.5989531
celmiR-37 st 378736663 0.634245 False 40778923 0.4338754 False 3.57381258 0.5591431
celmif-38 st 4214565 0.4738863 False 4 206368 0.04623421 True 4202371 0.1718871
celmif-39 st 410030651 09398 False 441063643 01544359 False 4172182 0.2201207
cebmiR-40 st 4258316 05550811 Falss 3601256 08854913 Falss 3.302637 0.7962233
celmiR-41 st 369530344 0.8738484 False 352844167 0.881606 False 3.77539182 0.5585453
1 cebmiR-42-star st 140979528 0.9513109 False 3.601266 0.8571414 False 3.81006 0.4592267
I celmiR-42 st 3709423 0.8501645 False 358574543 0.7284735 False 3.820654 0.5065453 .
I ::Tmm..ﬁ-u ANIRNAARA nﬁ_n_qam',ll Falee 407175969 N 2N1912 Falze 41732793 nRIL . 1
My | Show Detals I Annotations [0 Lecz T 2% Close.
Showing data after Summarization (Median Polish) - Log2 applied by process.

Figure 2.7 Example of multiple window arrangement: Cascade arrangement

Selection of Input Data: CEL Files

Each time the software starts, a CEL-files selection window opens up. This window contains a list of
previously selected files. On the first run, the CEL selection window (Figure 2.8) may appear empty.

i miRNAQCTool
File  Apalysis  Tablss  Graphs  Tools  Window  Help

it Cel Files to process ll

Add |
Remave |
Clear List |
_Gores |

Figure 2.8 CEL Selection window
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The addition of CEL files is accomplished by clicking the Add button, and selecting the CEL files
through a standard Windows input dialog (which allows for multiple selections). These files can be
removed from the list, using the Remove or Clear List button. Once all the CEL files needed for the
analysis are selected, click the Load button. When finished, the selection window closes, and you are
notified that the cel files were loaded successfully. The Analysis menu is enabled.

CEL files can be loaded later by accessing the File menu. More details are provided in Chapter 3, File
Menu on page 13.

File  Analysiz  Tables  Graphs  Tools  Window  Help

it Cel Files to process

| theFullPath
Hulung_2d_miRNAZ CEL |C:\
HuBrain_2a_miRNAZ CEL | C:\Affymetric_miRNAceffiles \HuBrain_2a_miRNAZ CEL
HuBrain_2b_miRNAZ CEL | C:\AMfymetrbc_miRNAceffiles \HuBrain_2b_miRNAZ CEL
HuBrain_2c_miRNAZ CEL | C:\Afymetric_miRNAceffiles \HuBrain_2c_miRNAZ CEL
HuBrain_2d_miRNAZ CEL | C:\Affymetrbc_miRNAceffiles \HuBrain_2d_miRNAZ CEL
Hulung_2a_miRNAZ CEL | C:\Afymetric_miRNAceffiles'\Hulung_2a_miRNAZ CEL
Hulung_2b_miRNAZ CEL | C:\Afymetric_miRNAceffiles \Hulung_2b_miRNAZ CEL
Hulung_Zc_miRNAZ CEL | C:\AMfymetric_miRNAceffiles \Hulung_2c_miRNAZ CEL

ymetrbe_miRhAc
Remove

Clear List

il

Figure 2.9 The interface for CEL files input. It displays the CEL file names and the full path. It allows for the adding of files one
at a time, or by selecting all the files together. Mouse hover shows a tool tip with the full file name.



Menus

File Menu

The basic input/output management is handled by the File menu (see Figure 3.1). This section describes
in detail each option of this menu.

Analysiz  Tables  Graphs  Tools  Window  Help
Load CEL Files...

Exit

Figure 3.1 File Menu

Loading CEL Files
To load CEL files, choose Load CEL Files... from the File menu. The CEL files to process window
appears. The use of this window is described in the section Selection of Input Data: CEL Files on page 11.
Tables Menu

Tables are available for each point of the analysis, as defined in the workflow!. Click the menu option
Tables (see Figure 3.2) to see the available options. All the tables can be exported and saved.

11t miRNAQCTool
File  Analysis Graphs Tools  Window  Help
Intensities Ctrl+T

Project Description
Quality Control

Pearson Correlation Coeffident

Figure 3.2 Tables Menu Options

' Prior to accessing this feature, an analysis must be run or this menu option will appear shadowed.
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Data Tables / Intensities

Data tables are provided for each step in the analysis workflow. Figure 3.3 and Figure 3.4 show examples
of this window. The tables show the intensities in a matrix format, where columns correspond to CEL
files and rows correspond to probes or probe sets (depending on the stage being visualized).

NIRNAQCTool - [Data Table]

File  Analysis Tables Graphs Tools  Window  Help

Data after Summarization (Median Polish) - Log2 applied by process.

ProbeSet Name | Hulung_... | p-value (... | Detectio... | HuBrain... | p-value (... | Detectio... |

65

ceHet-7-star st 3.937564 0.6393633 False 1.606683 0.5783676 False
ceHin-4 st 3.80536461 0.7640221 False 335884539 0483643 False
celdin-d-star st 4151354 0.4638723 False 3.81604052 0.435932 False
celmiR-1 st 404034138 0.7223458 False 412235055 0.4366331 False
cel-miR-2 st 3955415 0.656953 False 362165533 05314729 False
celmiR-34 st 1641423 0.7425651 False 3.55160761 0.5280683 False
celmiR-34-star st 4720758 0.185002 False 5.16430426 0.04305352 True

Figure 3.3 Example of table displaying the summarized data

Figure 3.3 and Figure 3.4 show an example of the analysis result displayed as a data table. In Figure 3.4,
the Show Details checkbox was selected to access the workflow and filters.

= The Probeset Filters checkboxes allow you to add or remove content from the table, such as main
content, control, background and other probes present in the chip.

= The data can be displayed as is or after Log2 and 2(x) transforms.
= Selection of the Annotations option adds annotation to the table.

= Tables can be exported as text files by clicking the Save button.

Data Table i} 10l =|
{Default) Data after Summanzation (Median Polish) - Log2 applied by process.
[+ Raw intensities ~!| ProbeSet Name | HuLung_... | p-value (... | Detectio... | HuBrain... |p-value*
: i CEL Files loaded
E| Detection
- " Background Detection celdet Tstar st 1937564 05333688 False 3606583 0.9783676
[=- Background Adjustment
"L BCCG Adist celdind st 3.830536451 07640221 False 399834939 0.489643
= “P"ga"ﬁ“l"” cellin-d-star st 4151934 04638723 False 3.81504052 0495832
uanﬁe
&1 Other Processes celmiR-T st 404034138 07223458 False 412295055 04358831
;- Add Small Constart (CYStabh| o0y o 3.955413 0656993 False 362169933 0.9314729
B- O_ther Processes
L Threshold celmif-34 st 3641423 0.7425631 False 155160761 05280683
. 5 szt A :
‘E|' SO | _,l—l celmif-3star st 4720758 0.135002 False 5.16430426 004305392
o celmif-35 st 1313388 03353375 False 1.32398085 05748435
5 Tian oot —1 | celmiR-36 st 418767165 01516112 False 419783028 0.1430861
I Background celmiR-37star st 378736687 07755316 False 377236366 03254301
™ r2_bac_spike_at_copyl {Contral)
™ r2_bac_spike_at_copy? (Cortrol) | | celmiR-a7 st 379736653 0634245 False 40778923 0.4338754
™ r2_bac_spike_at_copy3 {Control)
[T narnmbostior conbal Tartoa) celmiR-38 st 4214965 04738853 False 4206868 0.04623421
I oligo_spike_in {Cortrol) celmiR-33 st 410030651 03338 False 441063643 01544355 &
™ rl_bac_spike_at {Control) LI . | ’
¥ Show Details ™ Annotations M Leaz 2% Save | Clozse |

Showing data after Summarization (Median Polish) - Log2 applied by process,

Figure 3.4 Example of table displaying the workflow and filters
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Project Description Table

This table displays details of the current analysis. Figure Figure 3.5 shows an example of the table using
eight CEL files.

~lojxi

| HuLung... | HuLung_2c...

. | HuBrai...

| HuBrai...
431.912

- | HuBrain...

Mean Intensity

Mean Background Intensity

1155122 105.2084 102.5841 98.80477 |96.74322 95.30965

MNumber of Probes 202752 202752 202752 202752 202752 202752 202752 202752
Number of Detected Probes 34810 38452 39476 38332 35444 34203 35421 36302
Number of Probe Sets 20643 20643 20643 20643 20643 20643 20643 20643

Number of Detected Probe Sets 5185

Figure 3.5 Example of table displaying the workflow and filters

Quality Control Table

This table displays chip-specific control probes. For each CEL file, the values displayed are the average
(over the probes) raw intensities for each probe set. Figure 3.6 shows an example of the table using eight
CEL files.

| Group | HulLung... | HuBrain_... | HuBrai... | HuBrain_... | HuBrai... | Hulun... | HulLung...

AFFXr2EcclbioB-M_at |12 bac_spike_at.. [2350.09082 [2816.90918  |2393818  |240863647 | 2407.63647 27727271 | 2456
AFFX12-EcclbioB3 & |r2_bac_spke_at.. 289645459 [3571 3078182 |308672729 | 304536353 2938182 |3085.182
AFFXs2EcclbioC5 a |12 bac_spke_at.. (611618164 |7775.54541 6182364  [647745459  |6322273 6181 6623.909
AFFXr2-Ecc1hioC-3 = |r2_bac_spike_at... [r2 bac_spke_at copyl (Contra)}4822.091  |5082.636 4955.54541 | 4851 4939.45459 (5222273

AFFA+2-EcclbioD-5 & |r2_bac_spike_at.. |21250.5082 |26033.5443 218321816 | 22523.9082 222707266 (220737266 |21869.0918 |23273.7266

AFFA2-EcclbioD-3 & |r2_bac_spike_at.. |13888.0918 |25086.0913 19524.6367 |21139.6367 20466.8184 20183 200328184 | 21942

AFFA2-Plclcre-b at |12 bac_spike_at.. |33829.1836 |44363.6367 33456.91 36654 5465 34554 91 362252734 | 34640.51 377327266

AFFXr2-P1clcre-3 at |r2_bac_spike_at.. 37892 45859 5465 3743409 403457266 38560.8164 3504331 383782734  |41755.1836

AFFA2-Ecc2bioB-5 & |r2_bac_spike_at.. |2345 2834 54541 2364182 2501.182 2445 2473182 2364 45455 | 2560.182

AFFX12-Ecc2bioB-M_at |r2_bac_spike_at.. |2291.63647 (237450913 2300182 24142727 229927271 | 2372182 222345453 | 2507 54541

AFFA12-Ecc2bioB-3 & |r2_bac_spike_at.. |2556.182 3664.72729 303272723 (3157 3114 63647 3017182 2854182 315545455

Save Close

Figure 3.6 Quality Control Table
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Pearson Correlation Coefficient Table
This table displays the Pearson Correlation Coefficient between CEL files (Figure 3.7).

earson Correlation Coefficient = |EI|__)£|

Comelation Matro

CEL File
Hulung_2d_miRNAZ.CEL
HuBrain_2a_miRNAZ2 CEL
HuBrain_2b_miRNAZ CEL
HuBrain_2c_miRNAZ.CEL

Hulung_2a_miRNA2 CEL
Hulung_2b_miRNAZ CEL [ 66 1.7 7 [ 8 0 9945599
Hulung_2Zc_miRNAZ.CEL B 0.8042016 0.7951433

Save as Data Save as graphic Close

Figure 3.7 Pearson Correlation Coefficient

Graphs Menu
The miRNA QCTool software provides several ways of displaying results for analysis.
= Box Plots

Histogram Plots

MvA Plots

Quality Control Plots

Select the Graphs menu option to see the available options (see Figure 3.8).

File  Analysizs  Tables Tools  Window  Help
Box plots Ctrl+B
Histograms Ctrl+H
MvA plots Cirl+M
Quality Control Ctrl+Q

Figure 3.8 Graphs Menu Options

For all plots, similar to the Tables window, the user can choose to display graphical results for any
analysis stage by selecting the desired one from the workflow view on the left side of the window when
they click Show Details.

It is possible to save the graphs to various image formats, bitmap (bmp), Jpeg (jpg), and others, by
clicking on the Save button.
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Box Plots

The box-whisker plots are used to evaluate the overall consistency of the different samples within the
experiment. The plot summarizes the distribution of miRNA expression values for each sample so one
can readily identify potential outliers with distributions that may be different from the other samples in
the project. One can also evaluate the effect of normalization and how that influences the consistency of
distributions across the entire experiment. Selecting the Box Plot menu option displays a box plot of all
the CEL files, and allows zooming in by selecting the number of whiskers. Figure 3.9 shows an example
of the Box Plot window.

~lofxi
15 o
TLE A ——
4 i i
o e RE 28 B e = i1
q -7
T 13
=
E 9
25
-31
-3 -
i 4 4 4 3 4 4 g
™ Show Details 4 |'|
‘T Loge 1 2
2w ' J
Number of visible CEL files Save | Close |

Figure 3.9 Sample of box plot image for some sample CEL files

Main properties of the box plots are listed below:

= The line in the box indicates the median value of the data.

= The upper edge of the box marks the 75t percentile of the expression values.

= The lower edge of the box indicates the 25" percentile.

= The distance between the two quartiles is known as the inter-quartile range.

= The ends of the lines (whiskers) indicate the minimum and maximum data values.

The graphic, by default, includes all the chip probes types: background, miRNA, control and snoRNA.

The user can select which ones to include by checking or unchecking the checkboxes (visible when
checking Show Details).

Moving the mouse over a box plot displays the CEL file name, minimum, median and maximum
intensities. The data can be displayed as is or after Log2 and 2(x) transforms.
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Histogram Plots

The user can access this feature through the Histogram option on the Graphs menu. The histogram image
(see Figure 3.10) displays one or more CEL files in the same graph, by selecting them from the top right
list. It shows the original data unless the Log2 checkbox is selected. The histogram can be normalized to
show a density function. The smoothing option displays a smoother histogram.

Another option allows the user to display an aggregated histogram of many CEL files, selected in the
second list.

(=13
After Summarization (Median Polish) - Log2 applied by process.
10781
g 9583
5 8385 :
5 7187
g 1
g 5990
S 4T:2 f
T 3534 I
= 2396 | ll
1198 I ll
0 P
-42 -36 -31 -25 -18 -13 -7 -2 4 10 16
I~ Shoy~ Cel Files Agaregated Hist
i ™ Hulung_2d_miRNAZ CEL L ™ Hulung_2d_miRNAZ CEL s
" |"¥ HuBrain_2a_miRNA2.CEL ™ HuBrain_Za_miRNAZ2 CEL
[T 2% | HuBrain_2b_miRNAZ CEL ™ HuBrain_2b_miRNAZ CEL
rw | HuBrain_2c 1 2 CEL ™ HuBrain_2c_miRNAZ.CEL
M ¥ HuBrain_2d_miRNAZ2 CEL ™ HuBrain_2d_miRNA2.CEL
" Smot [ Hulung_2a_miRNA2 CEL LI ™ Hulung_Za_miRNAZ2 CEL LI
_x | _a |
Save | Close |

Figure 3.10 Sample of histogram image of some sample CEL files
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MvVA Plots

The MVA plot compares two experimental groups of samples. It shows the changes in expression between
two groups as a function of the average expression level of both groups. Each spot represents a unique
product (miRNA, snoRNA) as probe or probe set, depending on the analysis stage. The vertical axis is
the log2 fold-change, computed as the difference between the means (M) of the two samples!. The
horizontal axis shows the mean normalized signal (A) computed as the average of both samples (CEL
files). The user can access this feature through the MvA Plots option on the Graphs menu. Figure 3.11
shows an MvA plot window.

i1 MvA Plot =loix|

After Summarization (Median Polish) - Log2 applied by process.

3831

3.065

2299

1.532

0.766

Difference
o

-1.532

-3.065

-3.831
1 3 4 5 7 8 10 n 13 14 16

Mean values

I” Show Details CEL File 1 CEL File 2
I5 Eoag HuBrain_2a_miRNA2. CEL j HuBrain_2b_miRNA2. CEL
[ 2

Save Close

Mva plot of HuBrain_2a_miRMA2,CEL and HuBrain_2b_miRNA2,CEL

Figure 3.11 Sample of MvA plot for two CEL files

The MvA window displays the following information:

= The analysis stage used to generate the MvA plot.
m The two CEL files compared in the MvA plot.

These plots enable one to observe fundamental distortions in the data that may exist between the two
experimental groups. For example, if two experimental samples are well-matched, the majority of spots
will cluster along the horizontal line where y = 0. Furthermore, the extent to which the spots spread out
horizontally is an indicator of the dynamic range of those samples. If one sample replicate is plotted
against another single sample, it shows the variability as a function of the mean value for the two arrays.

! For instance, if the vertical axis is 2, there is approximately a four-fold difference between the expression values of the
two samples.
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Quality Control Plots

The Quality Control plot shows the average intensity (over the probes) of the quality probes sets across

the CEL files.

Figure 3.12 Sample of Quality Control Plot
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Analysis

Processing Steps

The processing algorithms are briefly described here. A more complete description of the algorithms can
be found in Appendix A, Algorithms on page 25.

Probe specific signal detection calls: Each probe on an array is assayed for detection.

For miRNA probes, detection is based on a Wilcoxon Rank-Sum test of the miRNA probe set signals
compared to the distribution of signals from GC content matched anti-genomic probes. If the resulting p-
value for the probes is p<=0.06, it is considered “detected above background”. For non-miRNA probes,
detection is at probe level, where for each probe, the p-value is the probability of generating a value equal
to or greater than the intensity, from the distribution of the background probes. Probe set p-value is
computed using a Fisher test, as a percentage of the probe's p-values (default is 50% or the median).
Probes with p-values > 0.06 have insufficient signal to discriminate from the background and are thus
considered “not detected”.

Background estimation and correction: The same set of anti-genomic probes used to determine detection
calls are used to estimate GC content matched background signals. Each miRNA probe signal has a GC
content matched background estimate subtracted from its value. This GC-specific background
contribution is estimated by the median signal from the distribution of GC-matched anti-genomic probes.
The resulting value may be negative at this stage, if the probe’s signal is less than the median value of
the GC-matched anti-genomic probes. The same process can be applied using two other ways to match
main content probes to background probes: a) by GC percent and b) by both GC content and probe length.

Constant Variance Stabilization on probes: Probe level constant variance stabilization is based on
adding a small constant to all the intensities. The default value of this constant is 16.

Normalization: Probe level normalization is provided via quantile, mean array scaling, and mean array
scaling (based on normalization probes) normalization algorithms.

Summarization: This process provides the quantification of probe intensities into probe set intensities
(via mean, median or RMA methods).

BC-CG Adjust: Background adjustment using ‘anti-genomic!” background probes, matched to miRNA
array species probe by GC count.

BC-CG % Adjust: Background adjustment using ‘anti-genomic’ background probes, matched to miRNA
array species probe by GC percentage.

BC-CG Adjust and Length adjust: Background adjustment using ‘anti-genomic’ background probes,
matched to miRNA array species probe by both length and GC count.

Quantile normalization: To compare the probe intensities across chips, cross chip variation needs to be
addressed, and the values normalized. A very commonly used and accepted normalization method that

assures that the distribution of log (probe intensities) is comparable among experiments, see BM Bolstad
RA Irizarry M Anstrand & TP Speed (2003) “A comparison of normalization methods for high density
oligonucleotide array data based on variance and bias”. Bioinformatics, 19 (2):185-193.

Mean array Scaling: A simple normalization method that assures that the mean of the log (intensities) of
probes are the same across experiments.

Mean array scaling (on Normalization probes): Separately apply mean scaling to normalization probes.

Add small Constant: To avoid probe intensities to drop below zero after Background-GC correction a
small constant is added to all intensities.

Threshold: Negative values are replaced by zero.

Mean: Intensities for probe sets are derived by taking the mean of the normalized intensities within the
probe set.

7 Sequences not found in human, mouse or rat genomes.
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Median polish: Median polish is a summarization method that essentially ignores outlier probe- level
values. Biostatistics. 2003 Apr;4(2):249-64. 2003.

Median: Intensities for probe sets are derived by taking the median of the normalized intensities within

the probe set.

Running an Analysis

To run or edit an analysis workflow, choose the Analysis menu option on the menu bar. The user is
presented with a single window displaying the selected workflow (see Figure 4.1), allowing for flexibility
regarding the addition of new options. In the event that the user wants to use the selected workflow with
default parameters, one just needs to click on the Run button. To select a pre-defined or a custom
workflow, the user can click the Workflows button, and choose it from a list of pre-defined workflows.

Cument Wordflow to Run

|iDefaut)

=

[=1- Detection

i Background Detection

E| Background Adjustment

. L BCLCG Adiust

E| Nomalization

¢ b Quantie

E| (ther Processes

¢ L. Add Small Constart (CVStab)
E| Cther Processes

B Summarization
‘- Median Palish

Worldflows | Fun I

Cancel |

Figure 4.1 Interface for Running an Analysis

The default parameters for each option can be modified by clicking File — New or File — New from
Current, or by accessing the Tools menu, and then selecting Workflow Editor. (See Figure 4.2). The
following section provides more details about editing workflows.

File  Analysis Tables  Graphs

Settings and Options. .. Ctrl+0

Ctrl+w

Figure 4.2 Tools menu option to edit workflows
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Workflow Editing

The workflow editor (see Figure 4.3) allows the user to add and modify analysis workflows.

The miRNA QCTool comes with pre-defined workflows, which provide the basic analysis steps, with

default parameters. If the user is comfortable with these, there is no need to access the workflow editing
part of the program, and one can simply select a pre-defined workflow with the Run button when running
an analysis. If the user wants to define specific analysis paths, with different options and/or parameters,
one can create them and save them using the workflow editor.

Figure 4.3 shows the main window for the creation and editing of workflows. The workflow tree on the
left side shows all the Available Processes. The workflow tree on the right side shows a proposed
workflow, built from processes listed on the left side.

To create a custom workflow, click File — New or File — New from Current. Give a name to the
custom workflow and click OK.

To add a step, simply click to select one of the available options in the left window, then click the

middle arrow button LI

To eliminate a step, click to select it in the right window, then click the ﬂ button to remove it.

To change the order of the analysis, click to select the step in the right window, then click the up :l
or down Ll button.

=1ofx
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- BC-CG Adjust
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Figure 4.3 Interface for workflow edition

After you have finished creating your new workflow, click File — Save (See Figure 4.4). A dialog box
appears indicating that “The workflow was updated.”
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Figure 4.4 Saving the new workflow
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All basic transformations, including detection for non miRNA probes, background adjustment, and
normalization, are implemented at probe level. Detection for miRNA probes is done at the probe set level.
Summarization is the operation that converts probe level data into probe set level data.

The following is a list of data processing algorithms that can be included in the workflow.
1.

Detection

A. DABG - Detected Above Background (using Wilcoxon Test for miRNAs)

Background Adjustment

A. BC-GC Adjust - Adjustment by GC content
B. BC-GC% Adjust - Adjustment by GC percent

C. BC-GC and Length Adjust - Adjustment by GC content and Probe Length
D. RMA background adjustment

Data Transformation

A. CVStab - Constant Variance Stabilization (Intensity + 16)

B. Threshold - Thresholding for negative values

Normalization

A. Quantile Normalization

B. Mean Array Scaling Normalization

C. Mean Array Scaling (on normalization probes) Normalization

Summarization

A. Median Polish - Median Polish Summarization

B. Mean - Mean Value Summarization

C. Median - Median Value Summarization



Algorithms

Detection

The detection algorithm is similar to the one implemented in the Affymetrix Power Tools (APT)!
Software, for all non-replicated probe sets, and uses the Wilcoxon Rank-Sum test for replicated probe
sets compared to the distribution of signals from GC content matched antigenomic probes. Replicated
probe sets are probe sets where all probes are identical replicates, and contain the same sequence. For this
chip, replicated probe sets are miRNA probe sets.

Detection Algorithm Description
The detection process is described below. The algorithm is applied independently on each
CEL file and probe set:

1.
2.

Wilcoxon Test

Process each CEL file one at a time.

The background probes intensities are grouped by GC content, into “Bins”, from 1 to 25 (Bins 1, 2,
3 have no probes).

For each probe set, software determines if it corresponds to a miRNA or another type.

If the probe set corresponds to a miRNA, the Wilcoxon test is applied. If not, the standard APT test
is applied.

Both tests are applied to one probe set (and its probes) at a time.

1. All the probes of the probe set are assumed to have the same sequence and same GC content.

2. Program determines the GC content for the probe set based on the GC content of the first probe.

3. Program tests the probes raw intensities against all the anti-genomic probes associated with the same
GC content (usually 96 probe sets, times 4 probes, equals 384 values), using the one-sided Wilcoxon
Rank-Sum non-paired test.

4. Usually, the two vectors to be compared are:

A. vector with 4 intensity values for the probe set being tested, and
B. vector with approximately 384 intensity values for the anti-genomic probes with same GC content.
5. The p-value obtained from the test is assigned to both the probe set and all of its associated probes.
Affymetrix Test

1. For each probe within the probe set, the software determines its GC content and then looks at the
distribution of the background probes for the same CEL file and GC content.

2. The p-value is defined by the probability of generating a value equal to or greater than the intensity
of the probe, based on the distribution of the background probes.

3. For both probes and probe sets, the Flag is defined as “1” when the p-value is less than or equal to
0.06, and “0” otherwise. Flag=1 indicate “detected” probes and/or probe sets.

4. This process is repeated for each CEL file.

T Affymetrix Power Tools are a set of cross-platform command line programs that implement algorithms for analyzing and working with
Affymetrix GeneChip arrays. APT is an open-source project licensed under the GNU General Public License (GPL).
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Background Adjust

The Background Adjust Algorithm is a new implementation of GC content background subtraction.

Algorithm Description
For each CEL file:

1. The background probes intensities are grouped by GC content, into “Bins”, from 1 to 25 (Bins 1, 2
and 3 have no data).

2. For each Bin, all the intensities of the probes with the associated GC content are used to compute a
median intensity.

3. For Bins with no data, use the median intensity of Bin 12.
The median for each Bin is the “correction” value for its associated GC bin.

5. For each non-background probe in the dataset, the program determines the GC content, and its
correction value, using the form probe signal- BG correction.

Wilcoxon Rank-Sum Test for Detection

Replicated miRNA probes are assayed for detection based on a Wilcoxon Rank-Sum test of the miRNA
probe signal compared to the distribution of signals from GC content matched anti-genomic probes. The
Wilcoxon Rank-Sum test compares two distributions to assess whether one has systematically larger
values than the other, based on the rank sum statistic W. For two samples of size nl and n2, it computes
the rank sum statistic w as the sum of the index (or rank) of the elements of the first sample after sorting
all the n1+ n2 values as a unique list. The test is based on the null hypothesis that the two samples are
produced by the same distribution. From the distribution of rank sums, when the null hypothesis is true,
a p-value is computed. If the p-value is small, the null hypothesis is rejected, and the probe is considered
present. The distribution of the rank sum statistic w becomes approximately normal when the two samples
are large. In this case the new variable:

Z=(W—puw)/ ow(A.1)
is a z-statistic, where:
pw=nl * (nl +n2 - 1)/ 2 (A.2)
and
ow=_ (nl*n2*(nl+n2+1)/12)(A.3)

In this case, the test is approximated by p = P(Z >= z), where z is the standardized version of the computed
rank sum W. We define a probe as “detected” if its p-value P(Z >= z) is lower or equal to 0.06.

Algorithm Description

1. Letnl (usually 4) be the number of non-background probes associated with a miRNA probe set, and
n2 the number of background probes with the same GC content.

Rank the nl probes in the nl + n2 total amount of probes.

Compute the rank sum W from this rank.

Compute the associated z value.

Compute the p-value as p = P(Z >= z) for a normal distribution N(0, 1).
If p <= 0.06, assign a “detected” flag to the probes and probe set.

N o v e WwWN

Otherwise, assign a “not detected” flag to the probes and probe set. Normalization and Summarization
Median Polish (See Irizarry RA, Hobbs B, Collin F, Beazer-Barclay YD, Antonellis KJ, Scherf U,
Speed TP. Exploration, normalization, and summaries of high density oligonucleotide array probe
level data. Biostatistics. 2003 Apr.4(2):249-64.)



Additional Information

Q&A

1. Can you export data by single species selection instead of having all species included?
Answer: You cannot export by species. You can only sort by species later in another tool like Excel.

2. On the annotations we are not ‘compliant’ with the international standards, i.e., we use the word ‘star’
instead of “*’ for naming the probes that hybridize to the antisense mature mirna. Also mirna should
be named miRNA is refers to a mature form. Why do our annotations not follow the standards?

Answer: The Windows OS and our Design software, do not allow “*” in probeset names or filenames,
so we substituted in the expression “star”

Definitions

= DAT file: The image of the scanned probe array.

= CEL file: The software derives the *.CEL file from a *.DAT file and automatically creates it upon
opening a *.DAT file. It contains a single intensity value for each probe cell delineated by the grid
(calculated by the Cell Analysis algorithm).

= CDF file: x, y coordinates for probes, probe set name and probe sequences
= QCC file: QC file that instructs what control probe sets to incorporate
= BGP: we eliminated the canonical MM probe. This file lists antigenomic probes based on GC content
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